
Panda Labels 2.0

Panda Labels is the most complete solution for the creation and printing of labels. This help aims to 
help you get to know Panda Labels better so that you can use and make the most of all the program 
functions.

View the main program window.

How to specify the label paper to be used.
How to open and save a label.

How to add elements to a label.
Label-creating facilities.
How to print labels.

Other options.



Main window

The main Panda Labels window is shown below. You can click on the different parts of this window to
obtain help.



Label format

The first thing to be decided before creating a label is the paper format to be used. Panda Labels 
includes predefined formats from all major label manufacturers. If the format you want to use is in the
list of predefined formats, all you have to do is select it. If the desired format is not in the list, you can 
define your own format.

To define your own format, you must introduce the following details: height and width of the paper, 
height and width of the label, number of horizontal and vertical labels and margins.

To save the defined format, just give it a name and press the "Save" button.





How to open and save a label

Once you have created a label, you will normally want to save it on disk so that you can retrieve it 
and work with it again. Moreover, with complex labels it is advisable to save every now and then so 
as not to lose the work you have done.

To open a previously saved label, just press the Open button in the toolbar or select the Open option 
from the main menu.

To save a label, press the Save button in the toolbar or select the Save As option from the main 
menu. If the label already has a name and you want to save over it, you can select the Save option. 
Panda Labels has two different formats with which you can save your labels: binary format and text 
format. You can use the format best suited to your needs as both contain the same information.



Elements that can be added to a label

Panda Labels possesses a wide range of different elements that can be incorporated directly into 
labels. Click on the element that interests you to get an explanation of its working and features.

Texts.
Variable texts.
Serial numbers.
Date and time.

Database fields.
Bar-codes.
Images.

Geometric elements: lines, rectangles and ellipses.



Texts

How to add a text to the label.
To add a text to a label, select the text element from the object bar. Once you have done this, define 
the rectangle that will delimit the text. Write the desired text. 

If you have the autosize in text objects option activated, the rectangle that delimits the text will be 
automatically adjusted to the introduced text.

How texts work.
Text elements remain constant from label to label. In other words, the text you introduce will be the 
same in all the labels printed.

Text properties.
To access the text properties window, just right-click the text element and choose the Properties 
option. You can also select the text and press the Properties button in the operations bar or choose 
the Properties option in the Operations menu.

The text properties window contains the following options:

Text: this section displays the text contained in the element.

Transparent: if this option is checked, the text element will be transparent, therefore enabling you to 
see what is underneath it.

Border: this option allows you to choose a simple, double or shaded text element border. It also 
allows you to indicate that you want no border.

Font: this option enables you to determine the text font.

Background color: this option allows you to determine the background color of the text element. It 
will not take effect if the element is transparent. You can also determine the text and background 
colors from the color bar.

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.



Variable texts

How to add a variable text to the label.
To add a variable text to a label, select the variable text element from the object bar. Once you have 
done this, define the rectangle that will delimit the variable text. Give the variable text an identifying 
title.

If you have the autosize in text objects option activated, the rectangle that delimits the text will be 
automatically adjusted to the introduced text.

The variable text represents a text element that can be defined at the time of printing or whenever 
the user chooses to do so. A title identifies the element until the definitive text is specified.

How variable texts work.
Variable text elements remain constant from label to label. In other words, the text you introduce to 
define the variable text will be the same in all the labels printed.

Variable text properties.
To access the variable text properties window, just right-click the variable text element and choose 
the Properties option. You can also select the variable text and press the Properties button in the 
operations bar or choose the Properties option in the Operations menu.

The variable text properties window contains the following options:

Text: this section displays the text contained in the element. It will remain blank until the desired text 
is introduced (before printing or whenever you choose to fill in the variable texts). When a text is 
introduced, the element will become a normal text.

Transparent: if this option is checked, the text element will be transparent, therefore enabling you to 
see what is underneath it.

Border: this option allows you to choose a simple, double or shaded text element border. It also 
allows you to indicate that you want no border.

Font: this option enables you to determine the text font.

Background color: this option allows you to determine the background color of the text element. It 
will not take effect if the element is transparent. You can also determine the text and background 
colors from the color bar.

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.



Serial numbers

How to add a serial number.
To add a serial number to a label, select the serial number element from the object bar. Once you 
have done this, define the rectangle that will delimit the serial number. A window will appear in which 
you can define the serial number: prefix, number, suffix and increment.

Both the prefix and suffix may be letters or numbers and will remain constant from label to label.

The number will vary according to the increment you have introduced. The increment can also be 
negative.

If you have the autosize in serial number objects option activated, the rectangle that delimits the text 
will be automatically adjusted to the serial number introduced.

How serial numbers work.
Serial numbers vary from label to label according to the specified increment. Prefixes and suffixes 
remain constant from one label to the next, thereby offering you maximum flexibility. The serial 
number option enables you to obtain sequentially-numbered labels with the greatest of ease.

Serial number properties.
To access the serial number properties window, just right-click the element in question and choose 
the Properties option. You can also select the serial number and press the Properties button in the 
operations bar or choose the Properties option in the Operations menu.

The serial number properties window contains the following options:

Prefix: shows the serial number prefix. It can be both a number or a text and remains constant from 
label to label.

Number: shows the serial number itself. This must be a number and will vary from label to label 
according to the specified increment.

Suffix: shows the serial number suffix. It can be both a number or a text and remains constant from 
label to label.

Increment: shows the serial number increment ratio. Therefore, the serial number of a label will 
always be the serial number of the previous label plus the increment (which may be negative).

Transparent: if this option is checked, the serial number will be transparent, therefore enabling you 
to see what is underneath it.

Border: this option allows you to choose a simple, double or shaded serial number border. It also 
allows you to indicate that you want no border.

Font: this option enables you to determine the serial number text font.

Background color: this option allows you to determine the background color of the serial number. It 
will not take effect if the element is transparent. You can also determine the text and background 
colors from the color bar.



Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.



Date and time

How to add a date and time field.
To add the date and/or time to a label, select the date and time element from the object bar. Once 
you have done this, define the rectangle that will delimit this field. A window will appear asking you if 
you want to show the date, the time or both concepts. You can also choose the date presentation 
format.

If you have the autosize in date and time objects option activated, the rectangle that delimits this field
will be automatically adjusted.

How date and time fields work.
The date and time field always represents the current system date and time. Therefore, if you want to
obtain labels with the date and time of printing, this is the easiest way to do so.

You must bear in mind that all labels printed at the same time will display the same date and time. If 
this same label is printed at a later time, it will display the new time of printing.

Date and time field properties.
To access a date and time field properties window, just right-click the element in question and choose
the Properties option. You can also select the element and press the Properties button in the 
operations bar or choose the Properties option in the Operations menu.

The date and time field properties window contains the following options:

Format: this feature allows you to specify whether you want to display the date in abbreviated format
or expanded format.

Transparent: if this option is checked, the date and time element will be transparent, therefore 
enabling you to see what is underneath it.

View date: if this option is checked, the field will display the system date.

View time: if this option is checked, the field will display the system time.

Separator: this option allows you to choose the separator between the different date values (day, 
month and year) when this is in abbreviated format.

Border: this option allows you to choose a simple, double or shaded date and time element border. It
also allows you to indicate that you want no border.

Font: this option enables you to determine the text font.

Background color this option allows you to determine the background color of the date and time 
element. It will not take effect if the element is transparent. You can also determine the text and 
background colors from the color bar.

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.





Databases

How to add database fields.
To add a database field to a label, select the database element from the object bar. Once you have 
done this, define the rectangle that will delimit the field. A window will appear asking you for the 
database you want to associate with the label and later for the database field you want to add to the 
label.

If you have the autosize in database objects option activated, the rectangle that delimits this field will 
be automatically adjusted to the text.

How database fields work.
Database fields display different database records from label to label. Therefore, if you want to 
produce labels with your clients' addresses, you can create "address", "postal code", "city" and 
"state" fields from your client database so that an address appears on each label.

The database element is therefore an element that varies from label to label.

Database field properties.
To access a database field properties window, just right-click the database element and choose the 
Properties option. You can also select the element and press the Properties button in the operations 
bar or choose the Properties option in the Operations menu.

The database field properties window contains the following options:

Field: this section shows the database field associated with the label.

Transparent: if this option is checked, the database element will be transparent, therefore enabling 
you to see what is underneath it.

Border: this option allows you to choose a simple, double or shaded database element border. It 
also allows you to indicate that you want no border.

Font: this option enables you to determine the text font.

Background color: this option allows you to determine the background color of the database 
element. It will not take effect if the element is transparent. You can also determine the text and 
background colors from the color bar.

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.

Database button bar.
ASSOCIATED DATABASES. Panda Labels has a button bar dedicated exclusively to database 
management. This database bar presents a field which shows the names of all the databases 
associated with the label. To perform any database operation, the database in question must be 
selected here. 



FILTERS. You may frequently want to work with only part of a database rather than an entire 
database. To do this you can activate a filter or view by using this button. The filter may be carried 
out by condition (only those records that fulfill certain conditions will be shown) or by record number 
(only those records whose numbers are specified will appear). In the former, the condition may be 
simple or complex. In the latter, individual numbers or ranges may be specified to make things 
easier.    

Therefore, when a filter is activated, it is like having a reduced database containing only the filter 
records.

SIMPLIFIED INSERTION. It is common practice to create a label with several fields from the same 
database. To avoid having to repeatedly specify the database when introducing the fields, you can 
use the simplified insertion option. Once you have introduced a field, by pressing this button a list of 
all the fields contained in this database will be shown. Just select the field you want to add and it will 
be inserted automatically. 

MOVING AMONG RECORDS. The possibility of moving among records can be used to consult 
different database values or to begin printing from a certain record. This option consists of four arrow 
buttons which allow you to go to the first record, last record, previous record or next record. The 
current record is shown in the middle.

You can also indicate a specific record number and press the "Enter" key to access this record 
immediately.

JOIN DATABASES. This option enables you to join two databases associated with the label in such a
way that one of them is the main database and the other the secondary. The only secondary records 
to be shown will be those that correspond with the main database. The joining of the two databases 
must be carried out through a field common to both databases.

FIND. This option allows you to look for a specified text in a database. Once you have introduced the
text, the first database record that contains this text (or part of it) will be shown. The search is 
performed in all the database fields (not only in those associated with the label).

The search mechanism finds the first occurrence of the text starting from the current record. 
Therefore, to find all occurrences of the specified text, go to the first record of the database and 
search through all the records.



Bar-codes

Note: bar-codes are only available in the professional version of the program.

How to add bar-codes.
To add a bar-code to a label, select the bar-code element from the object bar. Once you have done 
this, define the rectangle that will delimit the bar-code. A bar-code configuration window will appear in
which you must select the bar-code type and the value it will represent (this can be a fixed value, a 
variable value that will automatically increase from label to label or a variable value to be obtained 
from a database).

How bar-codes work.
There are three types of bar-codes: fixed, incremental or those taken from a database. The first type 
works like text elements, the second like serial numbers and the third like database elements.

Bar-code properties.
To access the bar-code properties window, just right-click the bar-code and choose the Properties 
option. You can also select the bar-code and press the Properties button in the operations bar or 
choose the Properties option in the Operations menu.

The bar-code properties window contains the following options:

Type: allows you to choose the type of bar-code you want to use.

Direction: allows you to indicate the direction in which you want to place the bar-code.

Transparent: allows you to indicate that you want the code background to be transparent.

Font: this option allows you to determine the text font.

Main code, Fixed: check this option if you want the bar-code to represent a constant value from 
label to label.

Main code, Incremental: check this option if you want the bar-code to increase or decrease from 
label to label.

Main code, Database: check this option if you want the bar-code to represent values obtained from 
a database field.

Additional code, Fixed: check this option if you want the additional part of the bar-code to represent
a constant value from label to label.

Additional code, Incremental: check this option if you want the additional part of the bar-code to 
increase or decrease from label to label.

Additional code, Database: check this option if you want the additional part of the bar-code to 
represent values obtained from a database field.

Position: this option lets you know and modify the position of the element on the label.



Dimensions: this option lets you know and modify the dimensions of the element.

Align pixels: this option is used to indicate that the pixels that make up the bar-code should be 
adjusted to a pre-established size in order to guarantee a correct bar-code reading.

Adjust text: this option determines whether the readable text of the bar-code should be stretched to 
adjust it to the width of the code.

Maintain appearance: this option is used to indicate that the bar-code should maintain a certain 
proportionality between the height and width of the bars in order to guarantee a correct reading.

EAN/UPC without cuts: this option is used to eliminate the cuts from EAN and UPC bar-codes, 
levelling the bars over the readable text code.

Code 39 Start/Stop: this option is used to determine whether you want to print the start and stop 
characters of a Code-39 type bar-code.

UPC Mini-digits: this option is used to indicate whether you want UPC mini-digits to be displayed.

Relative margins: relative margins refer to the distances between the bar-code and the borders that
limit the element. The relative margin between codes only takes effect in two-part bar-codes.

Relative widths of bars and spaces: this is where the relative widths of bars and spaces are 
indicated. Some codes have different types of bars and spaces and the relative width of each of 
these can be specified.

Space between characters: by combining this value with the relative widths, the space between the
different characters that make up the bar-code can be varied.

Type: you can indicate Panda Labels to vary the bar-code type from label to label. To specify the 
bar-code type, you must use a database. To do this, press the button to the right of "Type" to load the
database and choose one of the field options.

Size: as the bar-code type can change from label to label, their height and width should also vary. To 
do this, follow the same procedure as in "Type", selecting the database from which you are going to 
load these values and then indicating the fields that will represent them.



Images

How to add images.
To add an image to a label, select the image element in the object bar. Once you have done this, 
define the rectangle that will delimit the image. A window will appear asking you for the image file you
want to add to the label. Panda Labels can work with both bit map (BMP) files and Windows Metafile 
(WMF) files.

If you have the draw bitmaps with their real size option activated, the rectangle that delimits the 
image will be automatically adjusted to the size of the image. You may later change this size. If this 
option is not activated, the image will be adjusted to the defined rectangle, although it can also be 
returned to its real size by using the corresponding button in the operations bar.

How images work.
Images remain constant from label to label. In other words, the image you introduce will be the same 
in all labels printed.

Image properties.
To access the image properties window, just right-click the element in question and choose the 
Properties option. You can also select the image and press the Properties button in the operations 
bar or choose the Properties option in the Operations menu.

The image properties window contains the following options:

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.



Geometric elements: lines, rectangles and ellipses.

How to add geometric elements.
To add a line, rectangle or ellipse to a label, select the corresponding element from the object bar. 
Once you have done this, define the rectangle that will delimit the element. In the case of a line, you 
need only draw it on the screen.

How geometric elements work.
Geometric elements remain constant from label to label. In other words, the element you introduce 
will be the same in all labels printed.

Geometric element properties.
To access the geometric element properties window, just right-click the element in question and 
choose the Properties option. You can also select the element and press the Properties button in the 
operations bar or choose the Properties option in the Operations menu.

The geometric element properties window contains the following options:

Position: this option lets you know and modify the position of the element on the label.

Dimensions: this option lets you know and modify the dimensions of the element.

In the case of a line, the properties window shows the coordinates of its two extremes. By varying 
these values, you can modify both the situation and length of the line.



Label-creating facilities

Panda Labels possesses several features that enable you to create labels quickly and easily. These 
facilities allow you to precisely place different elements on the label. Click on any of the options 
shown below to obtain a more detailed explanation of its working.

Grid.
Guidelines.
Alignment.
Autosize.
Visualization of non-printable margins.



Grid

Use of the grid.
The grid facilitates the aligned and ordered positioning of different elements on the label.

The grid is a collection of dots on the label that form a mesh. These dots are NOT printed, as their 
function is only that of facilitating the creation of the label. The horizontal and vertical separation of 
the grid dots can be configured.

Both separations (horizontal and vertical) would normally be equal but grids with different 
separations can be defined depending on specific label needs. 

All objects will be positioned on one of the grid dots (their top left-hand corner will coincide with one 
of the dots).

How to activate/deactivate the grid.
To activate or deactivate the grid, just go to the "Grid" tab inside the "Configure" window in the 
"Options" menu. You can activate and deactivate the grid here as well as define its dimensions.

You can also choose between a visible or invisible grid. If the grid is deactivated, even though it is 
visible, it will not force the positioning of objects, although the dots will be shown as a guide. If the 
grid is activated but invisible, the dots will not be seen but will force the positioning of the different 
label elements.

How to use the grid.
If you have to apply certain separations between the different label elements, use these same 
dimensions to define the grid. This will enable you to align objects much more easily.

A very small grid loses its usefulness as it is similar to having no grid at all. If the grid is too big, it 
becomes uncomfortable to work with.

We recommend you to use a grid of    0.250 x 0.250. A grid is useful in most cases as it is easier to 
work with a grid than without one.



Guidelines

Use of the guidelines.
Guidelines are used to define the different label areas. They also help facilitate the modification of 
the different label element positions.

The guidelines attract all objects that are placed next to them. If a guideline is moved, all elements 
attached to it will also be moved.

How to add/remove guidelines.
To add a guideline, just click on the position you want on the corresponding ruler. A blue guideline will
appear. You can move this guide by dragging it with the mouse to the desired position.

To remove a guideline, just right-click it on the ruler.

How to use the guidelines.
Once a guideline has been placed, the label objects will be attracted to it when placed next to it. This 
enables you to position a guideline a certain distance from the element border and then quickly align 
the different objects.

Moreover, if a guideline is moved, all elements attached to it will also be moved, thereby facilitating 
label modifications. If an element is attached to two guidelines, and one of them is moved, the 
element will not be moved but will be stretched so that it remains attached to both guides.



Alignment

Use of the alignment functions.
The alignment functions help you to position and size elements in relation to others. For instance, 
you can align several elements with reference to another or make one or more elements adopt the 
width or height of a bigger or smaller element.

How the alignment buttons work.
The first group of buttons in the alignment bar allow you to align one or more objects in relation to 
another. The direction of the arrow indicates how the alignment will be performed. 

The first button will align objects to the left. If you select several elements and press this button, all 
will be aligned in relation to the element that is farthest to the left of those selected. The next three 
buttons have the same effect but to the right, up and down respectively. If any of these buttons are 
pressed when only one element is selected, this element will be moved to the corresponding label 
border.

The next group of buttons allow you to size objects in relation to another.

In the case of the first button, the objects selected will adopt the height of the biggest element. If 
several elements are selected when this button is pressed, all will be adjusted to the height of the 
biggest object selected. The next three buttons work in the same way and adjust objects to the 
widest, lowest and narrowest elements respectively.

The next two buttons allow you to center one or more objects on the label. If you press the first of 
these buttons, the elements selected will be centered vertically on the label. The second button will 
center selected elements horizontally.

The next button allows you to enlarge one or more objects so that they occupy the entire label 
surface.

The last button centers one or more elements both horizontally and vertically. It has the same effect 
as pressing the center horizontally and center vertically buttons one after the other.



Autosize

Use of autosize.
Text, variable text, serial number, date and time and database elements can be given any 
dimensions you want or can be automatically adjusted to the size of the displayed text. If these 
elements are adjusted to the texts they contain, you will not have to manually resize them in order to 
avoid overlapping with other elements.

The autosize option enables you to create labels much more quickly by avoiding the need to give text
elements the correct size.

How to activate/deactivate the different autosize options.
You can choose what elements will have this feature in the "Autosize" tab inside the "Configure" 
window in the "Options" menu. Configuration is independent for each of the element types.

How to use the autosize feature.
The autosize option for any of the different element types can be activated or deactivated when you 
begin a label or at any time during its creation.

It is advisable to have the autosize option activated in all element types. In this way, when one of 
them is added to the label you can define any kind of rectangle and it will be correctly sized as soon 
as you begin to write the text.



Visualization of non-printable margins

Note: this feature, as well as the print window and the preliminary presentation will only be available 
when there is a printer installed.

What are non-printable margins?
No printer is capable of printing on the entire page surface. Therefore, there will always be an area at
the edge of the page on which you cannot print. This non-printable area varies from printer to printer. 
Panda Labels possesses several tools that solve the problems associated with these non-printable 
margins when it comes to printing labels.

Use of the visualization of non-printable margins.
It is very useful to know in advance what parts of the label will be cut by the non-printable margins 
that each printer presents. This makes it much easier to create labels and saves time and label 
paper.

These margins are shown in the preliminary presentation. To avoid having to repeatedly consult the 
preliminary presentation to see whether an element will be cut or not, Panda Labels offers you the 
possibility of visualizing these non-printable margins on the label itself.

How to use the visualization of non-printable margins.
To visualize the non-printable margins on the label, go to the "Margins" option in the "View" menu. 
There are four sub-options within this option: "Top-Left", "Top-Right", "Bottom-Left" and "Bottom-
Right".

You can activate any of the four options or any combination of them.

If you activate "Top-Left", the non-printable margins that will affect the first label on the page will 
appear.

If you activate "Top-Right", the non-printable margins that will affect the last label in the first row will 
appear.

If you activate "Bottom-Left", the non-printable margins that will affect the first label in the last row will
appear.

If you activate "Bottom-Right", the non-printable margins that will affect the last label on the page will 
appear.

To view the four non-printable margins and find out if any of your labels will be cut, you need only 
activate "Top-Left" and "Bottom-Right".



How to print labels

Panda Labels possesses various printing options that enable you to configure a customized printout.
Panda Labels allows you to print from a configurable print window and from a very complete 
preliminary presentation that lets you see the final printing result in advance.

Note: the print window and preliminary presentation will only be available if there is a printer installed
on the computer.

Preliminary presentation.
Print window.



Preliminary presentation

Buttons
The preliminary presentation shows the result that will be obtained from the printer on screen. A 
window containing two pages is displayed on which the labels are defined.

A button bar enables you to work with the preliminary presentation. The first button allows you to 
choose whether you want to print a specific number of labels or the number that corresponds to the 
amount of records in the largest database associated with the label.

If you choose to print a specific number of labels, you must indicate the number of labels you want to
print in the second box in the button bar. If you have chosen to print from a database, the number of 
labels to be printed will be shown here.

Next to this are a number of buttons that allow you to move from one page to another. You can 
indicate a specific page number and this page will be displayed directly. If two pages are being 
shown on screen, the page number refers to the first of them. 

The next three buttons allow you to choose between a minimum zoom, a medium zoom or a real-
size zoom.

The last button allows you to send your work to the printer.



Labels you do not want to print
The preliminary presentation also allows you to remove labels you do not want to print. Just click on 
the label and it will turn gray, indicating that it will not be printed. By clicking on a marked label it will 
become unmarked again. If you want to mark a range of labels you do not want to print, just click on 
the first one and then, holding down the "Shift" key, click on the last one.



Print Window

The print window allows you to configure the work that is to be sent to the printer.

Number of labels to be printed: you can choose between printing a specific number of labels or the
number that corresponds to the amount of records in the largest database associated with the label.

Margin correction: these two values allow you to adjust the printout. If you notice a deviation of a 
few millimeters in your printout, you can try to adjust this using these two values. The margin 
correction feature tries to begin printing higher up and farther to the left. You must specify the number
of millimeters you want to displace the printout.

First label to print: this allows you to indicate the page position where printing will begin. This saves
label paper by beginning with the first free label on the page.

Number of copies per label: by pressing this button, you access a window in which you can 
indicate the number of copies of each label you want to print. When a label contains a serial number 
or data obtained from a database, all the labels are different, and you may want a different number of
each one. This can be achieved using this feature.

Printing marks: if this option is activated, printing marks will be printed to show the printing limit of 
each label.

Print as bit map: this option should only be activated if there are printing problems. If this mode is 
activated, Panda Labels will print using a totally different printing mode. This mode is considerably 
slower than the normal mode.

Print quality: this option is only available if you are printing in "bit map" mode. If this is the case, you
can choose the quality of your printouts. You must bear in mind that the higher the quality, the slower 
the process.





Other options

Various program features are grouped under this heading:

Operations that can be performed on the different label elements.
Database editor.
How to define variable texts.
Configuration.
Colors in the different elements.
Different ways of placing elements on a label.



Operations that can be performed on the different 
label elements

The operations bar allows you to perform different operations on the diverse label elements.

Bring to front: when you select an element and press this button, the element will be placed "on top 
of" others. If this element overlaps other elements, it will be displayed over them.

Send to back: when you select an element and press this button, the element will be placed "under" 
others. If this element overlaps other elements, it will be displayed underneath them.

Rotate: this button allows you to rotate elements by as many degrees as you want. The most 
common angles of rotation are provided, but any angle can be specified. The elements that can be 
rotated are: text, variable text, serial number, date and time, database, image and rectangle.

Round: this button allows you to round off one or more rectangles. You will be asked for the 
rounding factor and the corners of the rectangle(s) will be smoothed according to the specified factor.

Real size: this button returns all selected images to their original size.

Properties: this button displays the properties window of the selected element.

Remove: this button removes all selected objects.



Database editor

Creating a new database.
To create a new database, open the Panda Labels database editor using the "Database editor" 
option in the "Options" menu or by pressing F3.

Once you have opened the editor, select the "New" option in the "File" menu. In the window that 
appears, insert as many fields as you want to have in your database. Then define each of these 
fields by indicating its name, the type of data it is going to contain and its length.

Once you have accepted the database definition window, you will find yourself back in the editor. You
can then save the database by giving it a name and selecting the type of database you want: dBase, 
Paradox, Access, etc. Once the database is saved, all data introduced will be saved automatically 
without the need to save it each time.

Editing a database.
To edit a database, open the editor as explained above. Select the "Open" option in the "File" menu. 
Select the database file in the window that appears.

The database information will be shown in the database editor. Any changes made to the database 
will be saved automatically to disk. Because of this, it is IMPORTANT to be sure of the modifications 
you introduce.

The database editor button bar allows you to move through large databases as well as remove 
records or cancel operations in progress.



Variable texts

Variable texts enable you to create generic labels that act as templates and permit you to produce 
labels much more easily.

A name can be associated to these variable texts to help you identify them. This name will NOT be 
printed. When a label with variable texts is printed, a window appears asking you to introduce the 
definitive texts that should be printed in place of the variable texts.

This variable text window can also be activated from the corresponding button in the standard button 
bar or from the "Fill in variable texts" option in the "Options" menu.

Once they are filled in, the variable texts become normal texts. Therefore, if you want to save the 
master label with its variable texts to use as a template, you must take care not to save over the label
with the same name once the variable texts have been filled in.



Configuration

The "Configuration" window contains several tabs. Each one of them has a number of options which 
are explained in more detail below.

Various
Draw bit maps with their real size: this option indicates that regardless of the size given to an 
image element (bit map), it should first be drawn with its original size. The user may later vary the 
size of the element even though this option is activated.

Return to select mode: this option allows you to configure the behavior of the program after 
drawing an element on the label. When it is activated, you are returned to select mode after drawing 
an element. If it is deactivated, the element will remain selected in the object bar after it is drawn, 
thereby allowing you to immediately insert another identical image. Regardless of the status of this 
option, if you keep the Shift key pressed when you select an element from the object bar, it will 
remain selected after being drawn.

Rescale objects when the label is rescaled: if this option is checked, any variation in the size of 
the label will cause all label elements to be rescaled proportionally. If it is not checked, the variation 
in label size will not have any effect on its elements.

Save
Save filters with the label: if this option is checked, the filters applied to any of the databases 
associated with the label will be saved together with the label and will be activated every time the 
label is loaded. If it is not checked, the filters will not be saved. 

Save number of copies with the label: a different number of copies of each label can be printed. 
This option allows you to choose whether to save this information with the label or not.

Save bit maps with the label: this option allows you to decide whether to save the bit maps 
associated with the label or only the reference to these bit maps. The advantage of saving only the 
bit map reference is that when the bit map is changed, the label is automatically modified. This saves
you having to make changes to the label. To save the bit map, check this option. To save just the 
reference, uncheck the option.

Grid
Activate grid: if this option is checked, the grid will be activated according to the data specified in 
this tab. To deactivate, just uncheck the option.

View grid: this option determines whether the grid should be seen or not. If it is checked, a series of 
dots indicating the position of the grid will be seen. If it is not checked, this series of dots will not be 
seen. Even if the view option is not activated but the grid itself is, the program will only allow you to 
place elements according to the defined grid.

Grid width: this value determines the separation between two consecutive horizontal grid points.

Grid height: this value determines the separation between two consecutive vertical grid points.



Autosize
In text objects: if this option is checked, the autosize feature will affect all text elements, including 
variable texts.

In serial number objects: if this option is checked, the autosize feature will affect all serial number 
elements.

In date and time objects: if this option is checked, the autosize feature will affect all date and time 
elements.

In database objects: if this option is checked, the autosize feature will affect all database elements.

MS-Access
MS-Access 97: if this option is marked, Panda Labels will be prepared to access MDB databases if 
you have Access 97 installed in your computer.

MS-Access 95: if this option is marked, Panda Labels will be prepared to access MDB databases if 
you have Access 95 installed in your computer.



Colors in the different elements

You can use the color bar to choose the text and background colors of the different label elements.

To choose a text color, just click on the color you want in the color bar.

To choose a background color, right-click the desired color.

If you press the button that contains a circle with a dotted line (situated under the standard color 
palette), the selected object(s) will become transparent. This means that they will have no 
background color, thereby allowing you to see the elements under the object in question. When this 
button is activated, all elements drawn will have this characteristic.

Under the color palette, there are three boxes with arrows that enable you to select the type of 
outline, the background pattern and the thickness of the line for the elements you have selected.

Not all elements admit all the different possibilities offered in the color bar and it is important to bear 
in mind that some line and pattern types will only be correctly printed on PostScript printers.



Different ways of placing elements on a label

Panda Labels allows you to place elements on a label in a number of different ways. You can select 
the element from the object bar and then draw the rectangle that the object will occupy on the label. 
You can also double-click the corresponding element in the object bar. The element will be drawn 
with a predetermined size in the center of the label. Lastly, you can select the element in the object 
bar and then click on the label. The element will be drawn at the indicated point.

In addition to the above-mentioned features, Panda Labels offers you the possibility of configuring 
this aspect of the program behavior. By default, the program returns to select mode after drawing an 
element to allow you to adjust the inserted object. If you want to continue drawing elements identical 
to the one you have created, you can do this in two ways, one temporary and the other permanent. If
the element in the object bar is selected while pressing the Shift key, you will not be returned to 
select mode after drawing the element until you do so manually or select another element from the 
bar. If you want this effect to be permanent, uncheck the "Always return to select mode" option in the 
"Configuration" window.






